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Metabolic Case Study Glucose Kinetics: The Three-Compartment Model 

 

Glucose Kinetics: The Three-Compartment Model 
 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 
This case study is a modeling exercise which will show you the steps to go through to 
develop a system model. As such, it will exercise many features of the SAAM II 
Compartmental application. You will learn: 
 

• How to create a two-compartment system model. 
• How to obtain initial parameter estimates. 
• How to evaluate the “Fit” of the two-compartment model to the data. 
• How to add a third compartment to the system model. 
• How to obtain initial parameter estimates for the three-compartment model using 

information from the two-compartment model. 
• How to evaluate the “Fit” of the three-compartment model to the data, and how to 

add a fourth compartment if desired. 
• How to investigate different model structures (identifiability of the three-

compartment model) 
 
Data Required 
 

The data file for this case study is 
 

Glucose3Cpt.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
In this case study, you will learn how to proceed is a step-wise fashion to develop a 
system model. It is based on an analysis of glucose kinetics in sheep using the data given 
in [1]. The glucose dose is administered intravenously as a bolus, and serial plasma 
samples were taken for 240 minutes.  
 
We will begin with a two-compartment model, and then move to a three-compartment 
model. We will illustrate how to perform tests for goodness-of-fit, and how to use the 
Akaike and Schwartz criteria to aid in the selection between the two and three 
compartment model.  
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Although note required, it is highly recommended that you work through a case study on 
the two-compartment model. In these case studies, how to obtain initial parameter 
estimates for the two-compartment model is discussed. We will assume familiarity with 
these concepts in this case study. 
 
If you are interested in the steady state solution, it will be helpful to have worked through 
the case study “Glucose Kinetics: The Two Compartment Model” since the effect of 
different model structures on the steady state variables is discussed in detail in this case 
study. We will not cover this in detail in this case study. 
 
1. Gastaldelli, A. JM Schwarz, E Caveggion, LD Traber, DL Traber, J Rosenblatt, G 

Toffolo, C Cobelli and RR Wolfe. Glucose kinetics in interstitial fluid can be 
predicted by compartmental modeling. Am. J. Physiol. 272: E494-E505, 1997 

 
Part 1.  Create a two-compartment model in the SAAM II Compartmental 

application 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Create the following system model on the Drawing Canvas: 

 

 
Remember to have “Glucose” appear in Compartment 1, you will need to open 
the Compartment Attributes dialog box associated with that compartment. 
 

Part 2.  Create the system (tracee) model 
 
1. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 

unavailable and the Experiment tools are available. The Experiment Attributes 
dialog box will open. 
 
a. Enter “240” in the End at box. The Experiment Attributes dialog box will 

appear as shown below: 
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b. Click Done. The Create Experiment dialog box will appear on the Drawing 
Canvas.  

 
c. Click System to activate this Type. 
 
d. Type “Glucose” in the New Name box. The Create Experiment dialog box 

will appear as follows: 
 

 
 

e. Click Create. Notice that “Glucose” now appears below Experiment in the 
SAAM II Toolbox. Your system model will appear as follows: 

 

 
 

The compartment names have changed from 1 and 2 to Q1 and Q2. SAAM II 
uses capital letters to name the compartments for the system experiment while 
it uses small letters to name the compartments for the “experiment” 
experiment. 
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  Experiment vs. System. The Create Experiment dialog box is where you 
create your experiment. There are two types of experiments - “Experiment” 
and “System”. 
 
The Experiment type will invoke SAAM II’s differential equation machinery. 
When you create this type of experiment, your compartmental model will be 
interpreted by SAAM II as a system of differential equations. Once parameter 
values and inputs have been specified, SAAM II can Solve the system of 
differential equations, and can Fit your model to your data. This type of 
experiment is designed to deal with time dependent data following an 
experimental (exogenous) input into the system.  
 
The System experiment creates a system of algebraic equations whose 
coefficients are the k(i,j) of your compartmental model. The System model is 
used primarily in tracer-tracee experiments to describe the tracee data in the 
steady state. In this case study, it will be used to analyze steady state glucose 
kinetics. 
 

 The default New Name is “Exper”. This can be changed to a name of your 
choice. 

 
 

2. Specify the steady state (tracee) information. 
 

a. Double-click Compartment Q1 to open the Compartment Attributes dialog 
box. 

 
b. In the Equation pane, type “Q1 = conc * vol”. The Compartment Attributes 

dialog box will appear as follows: 
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Notice the experiment Reference Name appears in this dialog box. 

 
c. Click Done. 
 

 Specifying tracee masses in compartment. What is needed to solve the steady 
state problem is the tracee mass in either Compartment Q1 or Compartment 
Q2. As written, we are solving for the mass Q1. What is known is the 
concentration, conc, of glucose in Compartment Q1, plasma. To obtain the 
mass, we need the volume, vol, of this compartment. The equation 
“Q1=conc*vol” thus introduces two parameters in your model, conc and vol. 
The parameter conc will be entered as a fixed parameter since it is measured 
and known as part of the experiment. The parameter vol will be estimated 
from the tracer data. 

 
 If conc is, for example, 100mg/ml, the equation could have been written 

“Q1=100*vol”. However, if you had several turnover studies you were 
analyzing, this equation would have to be edited for every study. By 
introducing the parameter, you need only enter the parameter and not worry 
about this defining equation 

 
In writing the equations for the steady state, for every unknown U(i) there 
must be a known mass, and vice-versa. More specifically, it is not necessary 
to know the mass of a single compartment. If, in this case, the total glucose 
mass was known (total glucose mass would be Q1 + Q2), then the mass 
equation could be written: “Q1 = Total – Q2”. Remember in SAAM II, you 
cannot write equations of the form “Q1 + Q2 = Total”; there must be a single 
variable only on the left hand side of the equation. 

 
 

3. Estimate total glucose mass in the system. 
 

With Q1 calculated, when the system model is solved, you will obtain an estimate 
for the mass Q2 in Compartment Q2. You can thus calculate the total estimated 
glucose mass in the system as the sum of Q1 and Q2. 
 
a. In the Show menu, click Equations, or alternatively, click the Equations tool 

 on the SAAM II Toolbar. The Equations dialog box will open. 
 

b. In the Equations Defined Here pane, type “Q_tot = Q1 +Q2”. The 
Equations dialog box will appear as follows: 
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c. Close the Equations Dialog box. Q_tot is now a variable that will be 
estimated when you solve or fit your model to the data. 

 
Part 3. Create the tracer kinetic experiment on the model 

 
Remember the Experiment tools are active since you have been working with the 
system model. 
 
1. Create the tracer experiment. 

 
a. In the SAAM II Toolbox, click Create. The Create Experiment dialog box 

will open. 
 
b. Be sure “Experiment” is the active Type. Type “Tracer” in the New Name 

box. The Create Experiment dialog box will appear as follows: 
 

 
 
c. Click Create. Notice that the name “Tracer” appears just under Experiment 

in the SAAM II Toolbox. The model will appear as follows: 
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 Naming experiments. When you create an experiment, you have the option of 
giving it names other than the default name. In this case, the system 
experiment was named “Glucose” and the tracer study was named “Tracer”. 
Depending upon whether you have the system or tracer model active on the 
Drawing Canvas, the appropriate name will appear under Experiment in the 
SAAM II Toolbox. This option is very useful especially when you 
performing multiple tracer experiments. 

 
 

2. Create a sample on Compartment 1. 
 

a. In the SAAM II Toolbox, click Sample. 
 

b. Click Compartment q1, and then click on the Drawing Canvas. The sample 
s1 will appear. 

 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “plasma” in the Associate with Data Name box. (Notice “plasma” is in 

lower case.) 
 
e. Edit the sample equation “s1=q1” to read “s1=q1/vol” in the Equations box. 

The Samples Attributes dialog box will appear as follows: 
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f Click Done. The following warning message will appear: 
 

 
 

The reason why this message appears is that the data have not been entered in 
the Data window. This will be done later. 

 
g. Click OK. 

 
3. Create an input into Compartment 1. 

 
The dose of tracer glucose was 4.5 * 108 dpm. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 

c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Enter “4.5e+08” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box will appear as follows: 
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f. Click Done. Your model will appear as follows: 
 

 
 

4. Enter the data. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file Glucose3Cpt.dat should appear in the 

list (if it does not, find the folder where you have put this data file). 
 
c. Double-click Glucose3Cpt.dat. The Data window will appear as follows: 
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The weighting scheme is FSD so you can leave the variance model set as the 
default, data-relative.  

 
d. Close the Data window. 

 
 
Part 4. Enter the parameter values, solve the model, fit the model to data, view the 

solution and record the results. 
 
Before you can Solve (simulate) your model or Fit your model to your data, you must 
provide numerical estimates for the primary parameters of your model. These are the 
parameters that appear in the Parameters dialog box. First you need to obtain the initial 
parameter estimates.  
 

1. View your data using a line plot. 
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a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot  . The Plot and Table Variables dialog box will open. 
 
b. Be sure the List All Variables check box is selected. (Click this box if it is 

not selected). 
 
c. Click plasma to move it to the Current Selection pane. 
 
d. Click Done. A plot of the data will appear in the Plot window. 
 
e. In the View menu, click Line Plot. 
 
f. In the View menu, click Semilog. Change the Plot and Table Scale as 

follows: 
 

 
 

Your plot will appear as follows: 
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  Line Plots. Using the line plot in semilog mode to connect your data can help 
you decide how many exponentials (compartments) will be needed for the 
model. In this case, it is clear that at least two exponentials, or compartments, 
will be needed.  

 
Using the quick method to estimate the initial values for the three rate 
constants k(i,j), we see the break in the curve appears to be around 15 minutes. 
We will thus use 1/15 or 0.067 as initial estimates for the rate constants. 
 
The first datum has a value of 206701. Knowing the dose is 4.5 *108, an 
estimate for vol will be obtained 4.5 *108/206701 which equals approximately 
2200. 

 
 

g. Close the Plot window. 
 

 
2. Enter the parameter values. 

 
a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameter . The Parameters dialog box will open.  
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b. If conc is not selected, double-click conc to select it. Select “Fixed” as the 
parameter Type. Enter “10” in the Value box, and click Save. 

 
c. Enter the remaining parameters as shown in the Parameters dialog box 

below: 
 

 
 

d. Click Done. 
 

In the parameter dialog box, note conc is a fixed parameter. The measured 
concentration of glucose in this individual was 100mg%. Since the units of 
mass in the steady state model are mg, the concentration needs to be converted 
from mg% to mg/ml. Thus 100mg% is 10mg/ml. 

 

  Initial parameter estimates. How to obtain the initial parameter estimates is 
described in one of the two-compartment case studies. 

 
 

3. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
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b. In the View menu, select Model Labels and click Values. Your model will 

appear as follows: 
 

 
 

 Model labels. Model Labels gives you three options to label the transfers in 
your model. One is the name, k(i,j) which is the default label. The other is 
Values; this labels the transfers with their current values. In the event that a 
transfer is non-linear, the current value is the zero time value. The final option 
is no label at all. Labeling with the parameter value is useful since it lets you 
know the current value of each parameter without having to open the 
Parameters dialog box. 

 
 

c. Plot the data. In the Show menu, click Plot, or alternatively, on the SAAM II 

Toolbar, click Plot . Since you have previously plotted the data, the plot 
of the data will appear.  

 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is cleared. 
 

e. Click s1:plasma to move these to the Current Selection pane. 
 

f. Click Done. If your plot does not appear in semi-log mode, in the View menu, 
click Semilog. Your plot will appear as follows: 
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Remember you have set the Plot and Table Scale which is why the model 
predicted value disappears at approximately 60. If the scale has not been set 
but was on Autoscale, the plot would be very different as the model predicted 
value would appear to 240 minutes. 
 
The initial estimates from the quick method are not quite right as the model 
predicted values are disappearing faster than the data. While this is actually 
close enough to Fit the model to the data, it is useful to hand-fit first. 
 
In hand-fitting, we will choose one parameter at a time, and change its value 
by no more than twice or half. In this case, we will first reduce k(0,1) by a 
factor of one-half to 0.03. 

 
  Leave the Plot window open. 
 
g. Open the Parameter dialog box, and change k(0,1) to 0.03. Re-Solve the 

model. Your plot and model will be updated as follows: 
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While this is better, k(0,1) is still a little too large. We will reduce it again, but 
not by a factor of one-half since that will be too much. We will reduce it to 
0.02. 

 
h. Open the Parameter dialog box, and change k(0,1) to 0.02. Re-Solve the 

model. Your plot will be updated as follows: 
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This is much better, but you can see the initial points are not well estimated. 
This is because vol is a little off. Remember vol was estimated using the first 
datum which means it will be larger than the true estimated volume. We will 
reduce the estimate of vol to 2000. 

 
i. Open the Parameter dialog box, and change vol  to 2000. Re-Solve the 

model. Your plot and model will be updated as follows: 
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This is quite reasonable, and the parameter estimates were achieved using the 
quick method with just three hand adjustments to the parameters. This is 
certainly faster than formal curve peeling, or quick curve peeling. 
 
Be sure to leave the Plot window open. 

 
4. Fit your model to your data and view the solution and the statistics. 

 
a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click, Fit . Your model will be updated as follows: 
 

 
 
 Since your Plot window is already open, your plot will be updated and appear 

as follows: 
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The “fit” appears to be reasonable. 
 

b. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar 

click, Statistics . The Statistics window will open as follows: 
 

 
 

You can see that the statistics are quite reasonable in that no parameter has a 
large error.  
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You will have to scroll through the Parameter/Variable pane to see the 
steady state values for Q1, Q2, Q_tot and U(1). Remember the fluxes 
FLUX(I,J) are also calculated: “FLUX(I,J) = k(I,J)*Q(J)”. If you also select 
the Correlation Matrix option, the Statistics window will appear as follows: 
 

 
 

c. Record the results for the steady state variables and the parsimony criteria 
AIC and BIC. You will need this information when you compare the results of 
the two and three-compartment models. 

 
Two Compartment Three Compartment

Q1 19658
Q2 17207
Q3 0
Q_tot 36865
U(1) 342
OBJ 15.71
AIC 8.96
BIC 9.08  

 
 

5. Record the results in the Notes window (optional). 
 

You may record the results of your modeling exercise using the Notes window if 
you wish. You may also omit this part of the case study. The contents of the 
Notes window are included as Appendix 1. 
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If you do not do this part of the case study, close the Statistics and Plot windows 
and proceed to Step 6. If you do this part of the case study, leave these windows 
open. 
 
a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar 

click Notes . The Notes window will open. 
 
b. Type the text “Fit of the two-compartment model to data with loss from 

Compartment 1.” 
 
c. In the Statistics window, select all the information for all the parameters and 

variables (top pane).  
 
d. In the Edit menu, click Copy. 
 
e. Click in the Notes window to make it the current window. In the Edit menu, 

click Paste. Add the titles to the columns (e.g. value, SD, Coeff of Var, etc.) 
 
f. In the Statistics window, select the information for the objective function 

(you may have to make this active if you previously selected the Correlation 
Matrix option). 

 
g. Click in the Notes window. Click below the statistical information. In the Edit 

menu, click Copy. Your Notes window should appear as follows: 
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 Two or three compartments? At this point, you have successfully fit the two- 
compartment model to your data, and estimated the primary parameters and 
the steady state parameters. How do you know the two-compartment model is 
the appropriate model? This will be addressed below. We will first examine 
the residuals from this Fit, and (optionally) perform the runs test for goodness-
of-fit (described in Appendix 2). We will then add a third compartment to the 
model. 

 
 

h. Close the Statistics and Notes windows. 
 

6. View the residuals. 
 

a. The Plot window should be open. If it is not, in the Show menu, click Plot, or 

alternatively, on the SAAM II Toolbar, click Plot . The previous plot of 
the bit fit of the model to the data will appear. Click on the Plot window to be 
sure it is the current window. 

 
b. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
c. Select the List All Variables check box. 
 
d. Click s1_wres. This variable will move to the Current Selection pane. 
 
e. Click Done. The following plot will appear: 
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The plot is not informative for two reasons. First, you have previously set the 
scale; this plot retains that scale. Second the plot is in semi-log mode. This 
means that no negative residuals can be plotted. Both the scale and the semi-
log mode will need to be changed. 

 
f. In the View menu, click Semilog to return to a linear plot.  
 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
h. In the Y Axis pane, select Set. Enter “-2” in the Minimum box, and “2” in the 

Maximum box. The Plot and Table Scale dialog box will appear as follows: 
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i. Click Done. Your plot of the weighted residuals will appear as follows: 
 

 
 

  Residuals and weighted residuals. Plotting the residuals or weighted residuals 
can help you assess your goodness-of-fit; both contain the same information. 
The weighted residuals, however, should lie in a band between -1 and 1. In the 
above case, two features are immediately apparent. First, there are systematic 
deviations that are very clear because the residuals are not uniformly 
distributed about zero. This may not be immediately obvious by looking at the 
plot of the best fit of the model to the data.  

 
 

To perform the runs test, it is useful to have the weighted residuals in tabular 
form. 
 

j. In the Show menu, click Table, or alternatively, on the SAAM II Toolbar, 

click Table . Since the Plot window is already open with a plot of the 
weighted residuals, a table of the weighted residuals will open as shown in the 
following: 
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Now the systematic deviations are quite clear. How to perform the runs test is 
described in Appendix 2. 
 
Close the Table window (you can print the contents of this window if you 
wish to help with the runs test). 

 
k. Return to your plot of s1:plasma. (To return to this plot, you will have to 

open the Plot and Table Variables dialog box, and select s1:plasma. You 
will then have to open the Plot and Table Scale dialog box, and reset the 
scale for the Y Axis. You can either select the AutoScale option, or set your 
own high and low limits. The reason the scale needs to be reset is that it was 
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set manually for the plot of the weighted residuals.) An example of resetting 
the scale is shown in the following: 

 

 
 
l. Close the Plot window. 

 
Part 5.  Create a three-compartment model in the SAAM II Compartmental 

application 
 

1. In the SAAM II Toolbox, click Model to make these tools available. 
 
2. Modify your system model on the Drawing Canvas by adding a third 

compartment and associated fluxes as follows: 
 

 
3. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 

unavailable and the Experiment tools are available. Notice also that the 
Experiment Attributes dialog box, unlike the previous situation, will not open. 
This is because the experiment attributes have already been specified. The model 
(of the experiment) will appear as follows (you may need to move the sample or 
input): 
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  Modifying a system model. Suppose you have created your system model, and 
your experiment on the model. That is, you have specified your experiment 
attributes (in this case for both the system and tracer models). In addition, if 
you have edited your data file, the information will remain. That is, if you 
have unweighted any data, they will remain unweighted. When you modify 
your system model by adding more compartments or transfers, your 
experiment attributes do not change. What will change is the information 
required to solve your model, or fit your model to your data. When you add 
additional transfers, you must specify the initial values and limits (if they are 
adjustable). In this case, you have added a third compartment, Compartment 
3, and two transfers, k(3,1) and k(1,3). Thus to solve the model, you need only 
provide initial estimates and the limits for these parameters. 

 
 

4. Change the equation for Q_tot. 
 

Since you have added a new Compartment 3 to the model, the equation for Q_tot 
will change. Open the Equations dialog box, and modify the equation as shown 
in the following: 
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Close the Equations dialog box. 

 
5. Enter the parameter values. 
 

 Obtaining initial parameter estimates. When you build your model structure 
as we are doing in the case study, you need to provide initial estimates for 
your new parameters, in this situation, k(3,1) and k(1,3). You can use the best 
estimates from your two-compartment model as follows to obtain these 
estimates. In the case of the two-compartment model, the best estimates are  
vol = 1970, k(0,1) = 0.017, k(2,1) = 0.062 and k(1,2) = 0.071. You now need 
initial estimates for vol, k(2,1), k(1,2), k(3,1), k(1,3) and k(0,1) for the three-
compartment model. Let us assume Compartment 2 is the rapidly turning over 
compartment. 

 
i. Initial estimates for k(2,1) and k(1,2). Initial estimates for k(2,1) and k(1,2) 

for the three-compartment model can be obtained by doubling the average 
of k(2,1) and k(1,2) from the best fit of the two-compartment model. This 
number is about 0.133. 

 
ii. Initial estimates for k(3,1) and k(1,3). Initial estimates for k(3,1) and k(1,3) 

can be obtained by halving the average of k(2,1) and k(1,2) from the best 
fit of the two-compartment model. This number is about 0.033. 
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iii. Initial estimates for vol and k(0,1). Initial estimates for vol and k(0,1) can 
be obtained by using the best fit values for the two-compartment model. 
These are 1966 and 0.017 respectively. 

 
This rule of thumb in terms of obtaining initial parameter estimates works 
most of the time. When it does not, you may need to hand-fit to adjust some of 
the initial estimates. 

 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. Enter 
the parameter value as shown in the following:   

 

 
 

b. Click Done. 
 

6. Solve your model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 

©University of Washington Glu.3Cpt - 29 Rev. 03/06/17 



Metabolic Case Study Glucose Kinetics: The Three-Compartment Model 

b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. (It is 
possible that a plot of s1 and plasma will appear; if this is the case, you can 
view the solution, and skip to Part 7.) 

 
c. In the Plot and Table Variables dialog box, be sure the List All Variables 

check box is cleared to list only those variables associated with data. 
 
d. Click s1:plasma; it will move to the Current Selection pane. 
 
e. Click Done. The following plot with the model will appear (you will probably 

have to reset the Plot and Table Scale; the following has a Y Axis minimum 
and maximum of 13000 and 2.5e+05 respectively): 

 

 
 
The initial parameter estimates are sufficient so that we can proceed to fit the 
model to the data. Leave the Plot window open. 
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7. Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . When you have “Fitted” your model to your data, your model 

and plot will be updated as follows: 

 

 
 

b. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window will appear as follows: 
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The statistics appear reasonable with the largest coefficient of variation being 
about 38%. 

 
You will have to scroll through the Parameter/Variable pane to see the 
steady state values for Q1, Q2, Q_tot and U(1). Remember the fluxes 
FLUX(I,J) are also calculated: “FLUX(I,J) = k(I,J)*Q(J)”. If you also select 
the Correlation Matrix option, the Statistics window will appear as follows: 
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c. Record the results for the steady state variables and the parsimony criteria 
AIC and BIC. You will need this information when you compare the results of 
the two and three-compartment models. 

 
Two Compartment Three Compartment 

Mammillary
Q1 19658 17108
Q2 17207 11781
Q3 0 8366
Q_tot 36865 37255
U(1) 342 338
OBJ 15.71 14.60
AIC 8.96 8.48
BIC 9.08 8.65  

 
We will say more about which model is more appropriate in a moment.  
 
What are the differences between the two- and three-compartment models? 
The mass in Compartment Q1 has changed. The reason why is not that the 
measured concentration changed, but, because the three-compartment model 
describes the initial decay of the data better, there are differences in the 
estimated volume vol between the two models. For the two-compartment 
model, vol was 1966 while for the three-compartment model, it is 1710. 
 
It is of interests that neither the total mass Q_tot nor the synthesis U(1) 
changes very much between the two models. This is because both models 
provide a reasonable description of the data as indicated by comparing the 
values of the objective functions, and the parsimony criteria AIC and BIC. 
 
Still, as will be seen below, the three-compartment model can be judged to 
provide a better description of the data than the two-compartment model. 

 
8. Record the results in the Notes window (optional). 
 

You may record the results of your modeling exercise using the Notes window if 
you wish. You may also omit this part of the case study. The contents of the 
Notes window are included as Appendix 1. 
 
If you do not do this part of the case study, close the Statistics and Plot windows 
and proceed to Step 9. If you do this part of the case study, leave these windows 
open. 
 
a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar 

click Notes . The Notes window will open. 
 
b. Type the text “Fit of the three-compartment mammillary model to data with 

loss from Compartment 1.” 
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c. In the Statistics window, select all the information for all the parameters.  
 
d. In the Edit menu, click Copy. 
 
e. Click in the Notes window to make it the current window. In the Edit menu, 

click Paste.  
 
f. In the Statistics window, select the information for the objective function 

(you may have to make this active if you previously selected the Correlation 
Matrix option). 

 
g. Click in the Notes window. Click below the statistical information. In the Edit 

menu, click Copy. Your Notes window should appear in part as follows: 
 

 
 

h. Close the Statistics and Notes windows. Leave the Plot window open. 
 

9. View the residuals. 
 

a. The Plot window should be open. If it is not, in the Show menu, click Plot, or 

alternatively, on the SAAM II Toolbar, click Plot . The previous plot of 
the bit fit of the model to the data will appear. Click on the Plot window to be 
sure it is the current window. 

 
b. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
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c. Select the List All Variables check box. 
 
d. Click s1_wres. This variable will move to the Current Selection pane. 
 

e. Click Done. As before, the plot is not informative. Remember  you have 
previously set the scale; this plot retains that scale. Second the plot is in semi-
log mode. This means that no negative residuals can be plotted. Both the scale 
and the semi-log mode will need to be changed. 

 
e. In the View menu, click Semilog to return to a linear plot.  
 
f. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
g. In the Y Axis pane, select Set. Enter “-2.5” in the Minimum box, and “2.5” in 

the Maximum box. The Plot and Table Scale dialog box will appear as 
follows: 

 

 
 

h. Click Done. Your plot of the weighted residuals will appear as follows: 
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To perform the runs test, it is useful to have the weighted residuals in tabular 
form. This will also help to show that the residuals are more randomly 
distributed for the three-compartment model when compared to the two-
compartment model. 
 

i. In the Show menu, click Table, or alternatively, on the SAAM II Toolbar, 

click Table . Since the Plot window is already open with a plot of the 
weighted residuals, a table of the weighted residuals will open as shown in the 
following: 

 

©University of Washington Glu.3Cpt - 36 Rev. 03/06/17 



Metabolic Case Study Glucose Kinetics: The Three-Compartment Model 

 
 

You can use the information in this table to perform the runs test. How to 
perform the runs test is described in Appendix 2. You can see the systematic 
deviations present in the two-compartment model are not as evident here. 
 
Close the Table window (you can print the contents of this window if you 
wish to help with the runs test). 

 
j. Return to your plot of s1:plasma. (To return to this plot, you will have to 

open the Plot and Table Variables dialog box, and select s1:plasma. You 
will then have to open the Plot and Table Scale dialog box, and reset the 
scale for the Y Axis. You can either select the AutoScale option, or set your 
own high and low limits. The reason the scale needs to be reset is that it was 
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set manually for the plot of the weighted residuals.) An example of resetting 
the scale is shown in the following: 

 

 
 
k. Close the Plot window. 

 

 Which model is best?  You have two pieces of information to help determine 
which of the two or three-compartment model is most appropriate to describe 
the glucose data. These are the residuals and the parsimony parameters. The 
residuals in the case of the three-compartment model are better because they 
do not have systematic deviations. If you have performed a runs test, this 
observation can be confirmed. Second you have the parsimony parameters, 
AIC and BIC. Because those for the three-compartment are smaller than those 
for the two-compartment model, we choose the three-compartment model as 
the model best describing the plasma glucose data 

 
 To complete the exercise, you should try a four-compartment model. If you do 

(following the above rules for obtaining initial parameter estimates), in most 
cases you will have problems fitting with different parameter values hitting 
lower limits. In the event that you choose a set of initial values where you 
actually fit, you will find that some of your parameters have error estimates 
greater than 100%, and that the values for AIC and BIC for the four-
compartment model are larger than those for the three-compartment model. 

 
Thus you can safely choose the three-compartment model for glucose kinetics. 

 
 
Part 6.  Investigate the a priori identifiability of the three-compartment model 

(optional) 
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This part of the case study will investigate the a priori identifiability of the three-
compartment model.  
 
If you do not wish to work through this part of the case study, you may Quit the SAAM 
II Compartmental application. You can save your study file for future reference if you 
wish. 
 
There are actually 18 basic model structures for the three-compartment model making the 
situation much more complex than the situation for the two-compartment model. In this 
part of the case study, we will investigate the following two model structures: 
 

 
 
The first is the mammillary model but with the loss from a peripheral compartment rather 
than the central compartment. We will see this model is not a priori identifiable, but has 
two solutions. The second model, called a catenary model, is a priori identifiable. But 
when compared to the mammillary model, it has a different physiological interpretation. 
 
Thus, while both the mammillary model (with loss from the central compartment) and the 
catenary model are a priori identifiable, they had different physiological interpretations, 
and will have different estimates for the steady state variables. 
 

1. Work with the following model: 
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a. In the SAAM II Toolbox, click Model to return to the system model and 
activate these tools. 

 
b. Click on k(0,1), and then press Delete. (If you have the values option active, 

k(0,1) will appear with its current numerical value.) The following warning 
message will appear: 

 

 
 
c. Click OK. 
 
d. Click the Flux tool, and then click on Compartment 2 and the Drawing 

Canvas to create k(0,2). 
 
e. In the SAAM II Toolbox, click Experiment. Your model will appear as 

follows: 
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 Remember all Experiment Attributes have been set. 
 

  Loss from a peripheral compartment. In the first three-compartment model 
studied, the loss was from the central compartment (plasma). This model can 
be shown to be a priori identifiable; equations similar to those written for the 
two-compartment model can be produced (see the Case Study on the two-
compartment model). In the case when the loss is from a peripheral 
compartment, we will see that are in fact two solutions that minimize the 
objective function. The reason why is that one of the peripheral compartments 
turns over more rapidly than the second. Thus the loss can occur from either 
the rapid one, or the slow one. 

 
 
f. Enter the parameter values a shown in the following Parameters dialog box. 

 

 
 

g. Solve the model and view the solution. The plot will appear as follows: 
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h. Fit the model to the data. The model and plot will be updated as follows: 
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i. View the statistics. The Statistics window will appear as follows: 
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 Scroll to see the steady state variables. 
 

 
 
j. Record the results for the steady state variables and fitting information. An 

example follows: 
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Two Compartment Three Compartment 
Mammillary

Three Compartment 
Loss from Fast

Q1 19658 17108 17113
Q2 17207 11781 14092
Q3 0 8366 8347
Q_tot 36865 37255 39552
U(1) 342 338 338
OBJ 15.71 14.60 14.60
AIC 8.96 8.48 8.48
BIC 9.08 8.65 8.65  

 
k. Record the results as you have done previously in the Notes window 

(Optional). This part of the Notes window will appear (approximately) as 
follows: 

 

 
 
l. Close all open windows. 

 
2. Work with the following model (continued): 
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 In the above, we assumed Compartment 2 was the rapidly turning over peripheral 

compartment. We will now assume it is the slowly turning over peripheral 
compartment. 

 
a. Enter the parameter values a shown in the following Parameters dialog box. 

 

 
 

Notice in setting these parameter estimates, the roles of k(2,1) and k(1,2) are 
interchanged from the initial solution from k(3,1) and k(1,3). 

 
b. Solve the model and view the solution. The model and plot will appear as 

follows: 
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c. Fit the model to the data. The model and plot will be updated as follows: 
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You can see visually that this Fit is identical with the previous fit. The 
difference, however, is in the values for the rate constants. In the first Fit, 
Compartment q2 was the rapidly turning over compartment while in this case, 
it is the slowly turning over compartment. 
 
If you were not aware that two solutions existed for this model configuration, 
then you could reach erroneous conclusions from your model since the best-fit 
values of the parameters depend upon your initial estimates. 

 
d. View the statistics. The Statistics window will appear as follows: 
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 Scroll to see the steady state variables. 
 

 
 
e. Record the results for the steady state variables and fitting information. An 

example follows: 
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Two Compartment Three Compartment 
Mammillary

Three Compartment 
Loss from Fast

Q1 19658 17108 17113
Q2 17207 11781 14092
Q3 0 8366 8347
Q_tot 36865 37255 39552
U(1) 342 338 338
OBJ 15.71 14.60 14.60
AIC 8.96 8.48 8.48
BIC 9.08 8.65 8.65  

 
Three Compartment 

Loss from Slow
Q1 17119
Q2 19251
Q3 11816
Q_tot 48186
U(1) 338
OBJ 14.60
AIC 8.48
BIC 8.65  

 

  Steady state variables and model configuration. You can now compare the 
results of the three-compartment mammillary model. Production U(1) changes 
little. The reason is that production is always in the central compartment. You 
should experiment (as you did with the two-compartment model) changing 
U(1) to U(2), i.e. production into Compartment 2. If you do this, you will find 
significant difference, especially in the two situations we have just 
investigated. 
 
Thus when using this model to interpret you data including steady state data, it 
is important to think carefully about the compartment into which production 
will occur. 

 
 

f. Record the results as you have done previously in the Notes window 
(Optional). (The results are shown in Appendix 1.) 

 
g. Close all open windows. 
  

3. Work with the following model: 
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To create this model, you will have to delete Compartment 3 from the 
mammillary model, and you will have to delete k(0,2) from the previous model. 
You will then need to add Compartment 3 again, and create the fluxes k(3,2), 
k(2,3) and k(0,1). This model is called the catenary three-compartment model. 
 
In addition, because you deleted Compartment 3 from your model, it will be 
removed from the equation for Q_tot. Thus you will also need to open the 
Equations dialog box, and redefine Q_tot as the sum of Q1, Q2 and Q3. 
 
When you click on Experiment in the SAAM II Toolbox, the model will appear 
as follows: 
 

 
 
Remember the Experiment Attributes remain set. 

 
a. Obtain the parameter estimates. 
 

It is useful to explain how the initial parameter estimates are obtained for this 
three-compartment model configuration. When we worked with the 
mammillary model, we saw how to move from the two- to the three-
compartment model. The situation is exactly the same here, as explained in 
the following. 
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 Obtaining initial parameter estimates. When you build your model structure 
as we are doing in the case study, you need to provide initial estimates for 
your new parameters, in this situation , k(3,2) and k(2,3). You can use the best 
estimates from your two-compartment model as follows to obtain these 
estimates. In the case of the two-compartment model, the best estimates are 
vol = 1970, k(0,1) = 0.017, k(2,1) = 0.062 and k(1,2) = 0.071. You now need 
initial estimates for vol, k(2,1), k(1,2), k(3,2), k(2,3) and k(0,1) for the three-
compartment model.  

 
i. Initial estimates for k(2,1) and k(1,2). Initial estimates for k(2,1) and k(1,2) 

for the three-compartment model can be obtained by doubling the average 
of k(2,1) and k(1,2) from the best fit of the two-compartment model. This 
number is about 0.133. 

 
ii. Initial estimates for k(3,2) and k(2,3). Initial estimates for k(3,2) and k(2,3) 

can be obtained by halving the average of k(2,1) and k(1,2) from the best 
fit of the two-compartment model. This number is about 0.033. 

 
iii. Initial estimates for vol and k(0,1). Initial estimates for vol and k(0,1) can 

be obtained by using the best fit values for the two-compartment model. 
These are 1970 and 0.017 respectively. 

 
This rule of thumb in terms of obtaining initial parameter estimates works 
most of the time. When it does not, you may need to hand-fit to adjust some of 
the initial estimates. 

 
 
b. Enter the parameter values as shown in the following Parameters dialog box: 
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c. Solve the model and view the solution. The model and plot will appear as 

follows: 
 

©University of Washington Glu.3Cpt - 53 Rev. 03/06/17 



Metabolic Case Study Glucose Kinetics: The Three-Compartment Model 

 
 
The solution, while not perfect, is certainly close enough that we can proceed 
to Fit the model to the data. 

 
d. Fit the model to the data. The model and plot will be updated as follows: 
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e. View the statistics. The Statistics window will appear as follows: 
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 Scroll to see the steady state variables. 
 

 
 
f. Record the results for the steady state variables and fitting information. An 

example follows: 
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Two Compartment Three Compartment 
Mammillary

Three Compartment 
Loss from Fast

Q1 19658 17108 17113
Q2 17207 11781 14092
Q3 0 8366 8347
Q_tot 36865 37255 39552
U(1) 342 338 338
OBJ 15.71 14.60 14.60
AIC 8.96 8.48 8.48
BIC 9.08 8.65 8.65  

 
Three Compartment 

Loss from Slow
Three Compartment 

Catenary
Q1 17119 17118
Q2 19251 15105
Q3 11816 5045
Q_tot 48186 37258
U(1) 338 338
OBJ 14.60 14.60
AIC 8.48 8.48
BIC 8.65 8.65  

 

  Steady state variables and model configuration. You can now compare the 
results of the mammillary and catenary models. As with the mammillary 
models, U(1) does not change. However, production will change if it occurs in 
a non-plasma compartment. If you wish, you can remove U(1) and add a U(2) 
or U(3) to see how the variables in the steady state change. 

 
 

g. Record the results as you have done previously in the Notes window 
(Optional). (The results are shown in Appendix 1.) 

 
h. Close all open windows. 

 
Quit the SAAM II Compartmental application. You can save your study file for future 
reference if you wish. 
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Essential Points to Remember 
 
You now have four models that describe your kinetic data equally well. In the 
mammillary model, one has the loss from the central compartment, and the other two 
have the loss from a peripheral compartment, one that turns over rapidly and the other 
more slowly. Each model has a different physiological interpretation. The first is that all 
irreversible loss occurs from the central compartment while in the latter two, loss is from 
a peripheral compartment.  
 
In the mammillary model, the interpretation would be that the central compartment 
exchanges with two distinct peripheral compartments. In the case of glucose, one might 
be the brain and the other the remaining tissues – muscle, liver, etc. In the catenary 
model, the assumption is that the first peripheral compartment exchanges with a more 
slowly turning over “deeper” compartment. Here an interpretation could be the first 
compartment represents membrane bound substance and the second compartment 
substance that has been internalized. 
 
You thus need to think carefully when using the three-compartment model to interpret 
data from a single input-single output study. Besides just the structural interpretation, you 
should look at the results of the model predicted steady state variables. What is different 
and what does not change?  The changes are due to the different model configurations. 
 

• There are different commonly used structures for the three-compartment model. 
One can have two solutions and hence is not a priori identifiable. 

• When comparing the different solutions, although the model parameter values 
change depending upon the site of loss, the value of the objective function is the 
same. 

• Your derived parameters (in this case the steady state parameters but it can also be 
pharmacokinetic parameters) will depend upon which model structure is chosen. 

• It is important to know, a priori, if your model parameters can be estimated. In 
this case, with the loss from the peripheral compartment, which minimum is 
achieved depends upon your initial values. 

• Statistical methods can be used to decide on the number of distribution 
compartments that are optimal for pharmacokinetic analysis but, in some cases, an 
understanding of relevant physiology can also be brought to bear. 

• You can use information on the parameters in a “simpler” model to obtain initial 
parameter estimates in a more “complex” model; the case illustrated here was 
moving from a two to a three-compartment model. 

• The Notes window can be valuable in keeping track of your modeling session. 
The Notes window is printed in the Appendix 1. 
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Modeling Notes 
 
There is an intuitive reason why there are two solutions for this model. For the 
mammillary (loss from the central compartment) three-compartment model, one 
compartment exchanges rapidly with the central (plasma) compartment while the second 
exchanges more slowly. The choice for the two solutions comes from the two options of 
having the loss from the rapidly or slowly exchanging compartment. This is what was 
illustrated in this case study, and is an example of “flip-flop” kinetics. 
 
The three-compartment configuration where there is a bolus injection into the accessible 
pool has a solution that is a sum of three exponentials. Thus s1, the concentration in 
Compartment 1, can be written 
 

)*3exp(*3)*2exp(*2)*1exp(*11 taAtaAtaAs −+−+−=  
 
There are thus six parameters that can be determined, the three coefficients A1, A2 and 
A3, and the three exponentials a1, a2 and a3.  
 
The general three-compartment, without losses indicated, can be diagrammed: 
 

2

1

k(2,1)

k(1,2)

3

k(1,3)
k(3,1)

k(2,3)

k(3,2)

 
 
Assuming input and samples from Compartment 1, you can see immediately the various 
possibilities for the k(i,j). The models used in this case study, of course, did not have 
k(3,2) and k(2,3). If these parameters were present, and k(3,1) and k(1,3) were not 
present, one would have the catenary (chain) model: 
 
 

1

k(0,1)

2
k(1,2)

k(2,1)
3

k(2,3)

k(3,2)
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To grasp the nature of the difficulty, you should contemplate writing a set of equation 
similar to those that we derived in the identifiability analysis of the general two-
compartment model. 
 
If you are interested, you can try to develop them. Alternatively, they are derived in 
Cobelli, Foster and Toffolo Tracer Kinetics in Biomedical Research: From Data to 
Models (Kluwer Academic/Plenum Publishers, New York, 2000).
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Data for this Case Study 
 

DATA 
# Cobelli 3exp glucose data 
t    plasma (FSD 0.1) 
2    206701.    
4    171594.    
6    148425.    
8    134377.    
10    123580.   
12    119484.  
14    113790.   
16    109188.   
18    103288.   
20     99108.   
30     87073.   
40     78817.  
50     68707.  
60     64657.   
70     56928.   
80     51757.   
90     47496.  
105     42124.  
120     37425.  
135     32897.  
150     29102.  
165     24598.  
180     21427.  
195     19231.  
210     17596.  
225     15673.  
240     13689.  
END 
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Appendix 1:  Contents of the Notes window 
 
Fit of the two-compartment model to data with loss from Compartment 1 
 
Para/Var            Value        Std Dev     Coeff of Var     95% Confidence Interval 
conc                 10.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,1)                0.01741  5.87854e-004  3.37647e+000       0.01619       0.01863 
k(1,2)                0.07091  4.40428e-003  6.21143e+000       0.06180       0.08002 
k(2,1)                0.06206  6.60573e-003  1.06432e+001       0.04840       0.07573 
vol                1965.78849  6.78955e+001  3.45386e+000    1825.33575    2106.24123 
--------------------------------- Derived Variables --------------------------------- 
FLUX(0,1)           342.24921  2.04857e+000  5.98559e-001     338.01142     346.48699 
FLUX(1,2)          1220.06630  9.38890e+001  7.69540e+000    1025.84189    1414.29072 
FLUX(2,1)          1220.06630  9.38890e+001  7.69540e+000    1025.84189    1414.29072 
Q1                19657.88490  6.78955e+002  3.45386e+000   18253.35746   21062.41234 
Q2                17206.78558  6.44191e+002  3.74382e+000   15874.17348   18539.39767 
Q_tot             36864.67048  4.19663e+002  1.13839e+000   35996.52997   37732.81099 
U(1)                342.24921  2.04857e+000  5.98559e-001     338.01142     346.48699 
 
                          Objective      Scaled Data Variance 
s1 : plasma             1.570677e+001       8.651187e-002 
                       -------------- 
Total objective         1.570677e+001 
 
AIC                     8.957510e+000 
BIC                     9.077495e+000 
 
 
Fit of the three-compartment mammillary model to data with loss from Compartment 1 
 
conc                 10.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,1)                0.01976  8.03991e-004  4.06944e+000       0.01808       0.02143 
k(1,2)                0.14757  2.15374e-002  1.45947e+001       0.10278       0.19236 
k(1,3)                0.03109  6.16671e-003  1.98327e+001       0.01827       0.04392 
k(2,1)                0.10162  1.40911e-002  1.38658e+001       0.07232       0.13093 
k(3,1)                0.01520  5.70681e-003  3.75339e+001       0.00334       0.02707 
vol                1710.79501  6.96405e+001  4.07065e+000    1565.96986    1855.62016 
--------------------------------- Derived Variables --------------------------------- 
FLUX(0,1)           337.99836  1.67995e+000  4.97029e-001     334.50472     341.49200 
FLUX(1,2)          1738.59059  1.78363e+002  1.02591e+001    1367.66423    2109.51694 
FLUX(1,3)           260.11603  9.29184e+001  3.57219e+001      66.88201     453.35005 
FLUX(2,1)          1738.59059  1.78363e+002  1.02591e+001    1367.66423    2109.51694 
FLUX(3,1)           260.11603  9.29184e+001  3.57219e+001      66.88201     453.35005 
Q1                17107.95010  6.96405e+002  4.07065e+000   15659.69858   18556.20162 
Q2                11781.44015  1.38546e+003  1.17597e+001    8900.22185   14662.65846 
Q3                 8365.55710  1.44013e+003  1.72149e+001    5370.65800   11360.45621 
Q_tot             37254.94736  3.52395e+002  9.45901e-001   36522.10365   37987.79107 
U(1)                337.99836  1.67995e+000  4.97029e-001     334.50472     341.49200 
 
                          Objective      Scaled Data Variance 
s1 : plasma             1.459865e+001       3.128476e-002 
                       -------------- 
Total objective         1.459865e+001 
 
AIC                     8.477523e+000 
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BIC                     8.645502e+000 
 
 
Fit of the three-compartment mammillary model to data with loss from Compartment 2 where 
Compartment 2 is the rapidly turning over peripheral compartment 
 
conc                 10.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,2)                0.02403  2.86077e-003  1.19068e+001       0.01808       0.02998 
k(1,2)                0.12360  1.93290e-002  1.56389e+001       0.08340       0.16379 
k(1,3)                0.03111  6.16729e-003  1.98251e+001       0.01828       0.04393 
k(2,1)                0.12140  1.48247e-002  1.22118e+001       0.09057       0.15223 
k(3,1)                0.01522  5.71124e-003  3.75270e+001       0.00334       0.02710 
vol                1710.70119  6.96578e+001  4.07188e+000    1565.84019    1855.56218 
--------------------------------- Derived Variables --------------------------------- 
FLUX(0,2)           338.00217  1.68010e+000  4.97067e-001     334.50823     341.49612 
FLUX(1,2)          1738.74205  1.78454e+002  1.02634e+001    1367.62675    2109.85736 
FLUX(1,3)           260.35165  9.29830e+001  3.57144e+001      66.98329     453.72001 
FLUX(2,1)          2076.74423  1.78127e+002  8.57723e+000    1706.30930    2447.17915 
FLUX(3,1)           260.35165  9.29830e+001  3.57144e+001      66.98329     453.72001 
Q1                17107.01186  6.96578e+002  4.07188e+000   15658.40195   18555.62177 
Q2                14067.96930  1.63587e+003  1.16283e+001   10666.00677   17469.93183 
Q3                 8369.16306  1.44065e+003  1.72138e+001    5373.17288   11365.15323 
Q_tot             39544.14421  5.78599e+002  1.46317e+000   38340.88458   40747.40385 
U(1)                338.00217  1.68010e+000  4.97067e-001     334.50823     341.49612 
 
                         Objective      Scaled Data Variance 
s1 : plasma             1.459865e+001       3.128463e-002 
                       -------------- 
Total objective         1.459865e+001 
 
AIC                     8.477521e+000 
BIC                     8.645500e+000 
 
 
Fit of the three-compartment mammillary model to data with loss from Compartment 2 where 
Compartment 2 is the slowly turning over peripheral compartment 
 
conc                 10.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,2)                0.01756  1.12028e-003  6.38119e+000       0.01523       0.01989 
k(1,2)                0.01338  5.32240e-003  3.97910e+001       0.00231       0.02444 
k(1,3)                0.14699  2.13619e-002  1.45329e+001       0.10257       0.19141 
k(2,1)                0.03478  6.14085e-003  1.76541e+001       0.02201       0.04755 
k(3,1)                0.10145  1.40067e-002  1.38059e+001       0.07233       0.13058 
vol                1711.89851  6.94404e+001  4.05634e+000    1567.48948    1856.30755 
--------------------------------- Derived Variables --------------------------------- 
FLUX(0,2)           337.97084  1.68921e+000  4.99811e-001     334.45794     341.48375 
FLUX(1,2)           257.49888  9.22615e+001  3.58299e+001      65.63098     449.36679 
FLUX(1,3)          1736.78589  1.77367e+002  1.02124e+001    1367.93179    2105.63998 
FLUX(2,1)           595.46973  9.32411e+001  1.56584e+001     401.56469     789.37477 
FLUX(3,1)          1736.78589  1.77367e+002  1.02124e+001    1367.93179    2105.63998 
Q1                17118.98514  6.94404e+002  4.05634e+000   15674.89478   18563.07551 
Q2                19250.95486  1.16884e+003  6.07159e+000   16820.22385   21681.68587 
Q3                11815.65809  1.38248e+003  1.17004e+001    8940.63330   14690.68287 
Q_tot             48185.59809  2.39006e+003  4.96012e+000   43215.19874   53155.99743 
U(1)                337.97084  1.68921e+000  4.99811e-001     334.45794     341.48375 
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                          Objective      Scaled Data Variance 
s1 : plasma             1.459873e+001       3.128715e-002 
                       -------------- 
Total objective         1.459873e+001 
 
AIC                     8.477562e+000 
BIC                     8.645540e+000 
 
 
Fit of the three-compartment catenary model with input and loss from the plasma compartment 
 
conc                 10.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,1)                0.01974  8.00787e-004  4.05596e+000       0.01808       0.02141 
k(1,2)                0.13205  1.63255e-002  1.23635e+001       0.09810       0.16600 
k(2,1)                0.11652  1.66671e-002  1.43042e+001       0.08186       0.15118 
k(2,3)                0.03448  7.95379e-003  2.30712e+001       0.01793       0.05102 
k(3,2)                0.01149  4.36855e-003  3.80195e+001       0.00241       0.02058 
vol                1711.84266  6.94541e+001  4.05727e+000    1567.40529    1856.28004 
--------------------------------- Derived Variables --------------------------------- 
FLUX(0,1)           337.97689  1.68575e+000  4.98776e-001     334.47119     341.48259 
FLUX(1,2)          1994.61249  2.11349e+002  1.05960e+001    1555.08924    2434.13574 
FLUX(2,1)          1994.61249  2.11349e+002  1.05960e+001    1555.08924    2434.13574 
FLUX(2,3)           173.56516  6.00286e+001  3.45856e+001      48.72905     298.40127 
FLUX(3,2)           173.56516  6.00286e+001  3.45856e+001      48.72905     298.40127 
Q1                17118.42662  6.94541e+002  4.05727e+000   15674.05288   18562.80036 
Q2                15105.40148  6.77866e+002  4.48758e+000   13695.70373   16515.09923 
Q3                 5034.52011  8.02103e+002  1.59321e+001    3366.45875    6702.58148 
Q_tot             37258.34821  3.53885e+002  9.49815e-001   36522.40479   37994.29163 
U(1)                337.97689  1.68575e+000  4.98776e-001     334.47119     341.48259 
 
 
                          Objective      Scaled Data Variance 
s1 : plasma             1.459872e+001       3.128678e-002 
                       -------------- 
Total objective         1.459872e+001 
 
AIC                     8.477556e+000 
BIC                     8.645534e+000 
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Appendix 2:  The Runs Test for Goodness-of-Fit 
 
The runs test for the two-compartment model is performed as described below. If you do 
not know how to perform or interpret the runs test, please consult any standard book on 
statistics or biostatistics. 
 
It is assumed you have visualized the weighted residuals for both the two- and three-
compartment models. The table of the residuals is reproduced in the following for 
convenience. 
 

1. The table of weighted residuals for the two-compartment model is shown in the 
following: 
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From the table, there are 27 (weighted) data points used in the “Fit”; thus for the 
runs test, N = 27. Notice “240.000” appears twice; SAAM II prints out the final 
experiment time twice. Also notice there are some time values for which there are 
no weighted residuals. In your Computational Settings dialog box, the 
Minimum Number of Calculation Intervals is the default 20. Thus there will be 
solution values that are saved at time where there are no data. If you wish to 
remove this, you can set the Minimum Number of Calculation Intervals equal 
to 1. 

 
2. Calculate the Z variable. 
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a. N, the number of data, is 27. 
 
b. The number of positive and negative residuals, n+ and n-, is respectively 13 

and 14. 
 
c. The number of runs R equals 9. (Remember a run is a sequence of positive or 

negative residuals; a run can consist of only one, or several, positive or 
negative residuals). 

 
d. Estimate the mean, variance and standard deviation from the formulas shown 

below: 
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e. Calculate the Z variable: 

 

 12.2
54.2

48.149
−=

−
=Z  

 
For a 5% significance level to see whether the “Fit” should be accepted or not, Z should 
be in the interval [-1.96,1.96]. Since it is not, the test for goodness-of-fit indicates that the 
“Fit” cannot be accepted. 
 
The runs test for the three-compartment model is performed as described below.  
 

3. The table of weighted residuals for the three-compartment model is shown in the 
following: 
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As above, N = 27. 
 

4. Calculate the Z variable. 
 

a. N, the number of data, is 27. 
 
b. The number of positive and negative residuals, n+ and n-, is respectively 14 

and 13. 
 
c. The number of runs R equals 11. (Remember a run is a sequence of positive or 

negative residuals; a run can consist of only one, or several, positive or 
negative residuals). 
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d. Estimate the mean, variance and standard deviation from the formulas: 
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e. Calculate the Z variable 

 

 37.1
54.2

48.1411
−=

−
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For a 5% significance level to see whether the fit should be accepted or not, Z should be 
in the interval [-1.96,1.96]. Since it is, the test for goodness-of-fit indicates the fit can be 
accepted. 
 
The conclusion, based upon the goodness-of-fit test, is that the three-compartment model 
provides a satisfactory fit to the data. Acceptance of this model comes from the fact that 
the parsimony parameters, AIC and BIC, are less for the three- than the two-compartment 
models. 
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